# DegreePlan & SEP Plan - Student Tutorials

## Table of Contents

<table>
<thead>
<tr>
<th>Instruction Guide Links</th>
<th>Tutorial Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Understanding DegreePlan &amp; SEP Plan</strong></td>
<td></td>
</tr>
<tr>
<td>1) DegreePlan vs SEP Plan (Student Educational Planner)</td>
<td>Video</td>
</tr>
<tr>
<td>2) Preparing to Build Your SEP Plan</td>
<td>Video</td>
</tr>
<tr>
<td><strong>How to Create &amp; Edit Your SEP Plan Using a Blank Plan or a Template</strong></td>
<td></td>
</tr>
<tr>
<td>3) Create a New Plan by Using a Blank Plan</td>
<td>Video</td>
</tr>
<tr>
<td>4) Overview of Edit View &amp; Audit</td>
<td>Video</td>
</tr>
<tr>
<td>5) Add a Term</td>
<td>Video</td>
</tr>
<tr>
<td>6) Add a Course — Drag &amp; Drop</td>
<td>Video</td>
</tr>
<tr>
<td>7) Add a Course Requirement</td>
<td>Video</td>
</tr>
<tr>
<td>8) Move a Course Between Terms — Just Drag &amp; Drop!</td>
<td>Video</td>
</tr>
<tr>
<td>9) Delete a Course or Term</td>
<td>Video</td>
</tr>
<tr>
<td>10) Reassign a Term</td>
<td>Video</td>
</tr>
<tr>
<td>11) Refresh Audit</td>
<td>Video</td>
</tr>
<tr>
<td>12) Create a New Plan Using a Selected Template</td>
<td>Video</td>
</tr>
<tr>
<td>13) Overview of SEP Template (Symbols &amp; Selections)</td>
<td>Video</td>
</tr>
<tr>
<td><strong>Understanding Choice Requirements</strong></td>
<td></td>
</tr>
<tr>
<td>14) Choice Requirement — Selecting a Course from a List of Options</td>
<td>Video</td>
</tr>
<tr>
<td>15) Add Course to Choice Requirement Using Search Button</td>
<td>n/a</td>
</tr>
</tbody>
</table>

*Revised: 05/24/2018*
Understanding DegreePlan & SEP Plan

#1: DegreePlan vs SEP Plan (Student Educational Planner)
There are two tools that assist students with mapping out their program of study through graduation

- **DegreePlan** is a live audit of your progress through your curriculum
  - In Student Connection, click on the “DegreePlan” icon in the primary banner
  - You can track completed courses, scheduled and upcoming courses, as well as any transferred course work
  - Your DegreePlan will be audited at the end of your studies to verify your graduation requirements. If all requirements have been met, we will award your degree!

- **Student Educational Planner (SEP)** is a tool that allows you to lay out your courses, term by term, to fulfill graduation requirements
  - To access SEP: In DegreePlan, click on “Plans” tab
  - Benefits of using SEP:
    - Provides a roadmap to keep you on track for graduation
    - Takes the guesswork out of selecting your courses
    - SEP Plans will guide academics in planning course offerings each year
  - Note: The SEP Plan is **not** integrated with our registration system
    - Adding courses to your SEP Plan does **not** mean you are registering for these courses
    - You can only register for courses through Self-Service Banner (Student Connection) or with your advisor

#2: Preparing to Build Your SEP Plan

1. Find your Program Sequence on DU website
   a. Click “Programs” at the top of your Student Connection page

   b. Scroll down to the list of programs offered at DU – click on your curriculum
   c. Scroll to “Full Curriculum” on the curriculum page
      i. If you are pursuing a College of Health Professions curriculum, click on the “Program Curriculum” link on the program page to view the full curriculum
d. Click the PDF download of the recommended program sequence

Which class should I take? When should I take it?
2017-2018 Recommended Program Sequences for Marketing, BBA:

Marketing, BBA and printable pdf download

Specialty: Digital Marketing and Promotion and printable pdf download

Specialty: Marketing Technology and printable pdf download

Specialty: Value Chain and printable pdf download

2. Using your DegreePlan as your guide, CROSS OUT courses on the Program Sequence that are completed or being completed this term
   a. Courses for which you received articulation credit
   b. Courses for which you received transfer credit
   c. Courses for which you received credit by exam
   d. Courses scheduled for this term

3. Highlight (or asterisk *) courses on the Program Sequence that you are scheduled to take in upcoming terms
   a. Check your DegreePlan for future scheduled courses

4. You are now ready to create your Student Educational Plan
How to Create & Edit Your SEP Plan Using a Blank Plan or a Template

#3: Create a New Plan by Using a Blank Plan
To begin, login to Student Connection and click on the DegreePlan icon along the primary banner.
1. Select the “Plans” tab.
2. If no plans exist yet, the Create Plan box will appear - click on “Blank Plan” to start a plan from scratch.

3. The plan will display on your screen.
   a. In Description field, name the plan. Tab out of the Description field.
   b. If you wish to make this plan your primary plan, check the “Active” button. You can only have ONE plan marked as Active.
   c. Click on “Save” in the lower right corner of screen.

#4: Overview of Edit View & Audit
If you are entering an already-created plan, the plan will default to the Calendar view.
When first entering a new plan, the plan will default to the Edit view.
1. Left side of page is the edit area where you can build semesters of planned courses.
2. Right side of page compares the plan to your curriculum audit (the Worksheet tab), showing any “still needed” courses within the curriculum.
   a. Hover over each section to see description of unmet conditions.
   b. Use blue arrows to open up each section and view specific unmet course requirements (“Still Needed”).
   c. “Still Needed” indicates courses that you have not yet completed or included in your SEP Plan.
3. At top of the plan, the “Active” box can be selected. While you can create multiple plans, you can only designate ONE plan as “Active”.
   a. It’s important to mark your primary plan as “Active” to assist the university with course sequencing decisions year to year
4. At top of the plan, “+” button allows you to add semesters (or terms). It will only show terms not currently in use in the plan.
5. At top of each semester, “+” and “-” buttons allow you to add or delete items in that semester.
6. It’s important to click the “Save” button periodically as you add courses or make edits in the plan.

View the Audit
How does the SEP Plan compare to your DegreePlan?
1. Click on “Audit” button at bottom of the plan.
   a. Notice that this view is similar to your DegreePlan located in the Worksheet tab.
   b. Audit shows completed and current courses – similar to DegreePlan.
   c. Audit does not display future enrolled courses, it will only show planned courses from your SEP Plan.
2. Click on “X” in upper-right corner of audit to close the screen.
#5: Add a Term

1. At top of the plan, click on “+” button (hover over + and Add Term will appear).
2. Select desired term
   a. It will only show terms not currently in use in the plan.
3. In each Term bar, there are “+” and “-” buttons that allow you to add or delete requirements as well as a “Reassign” button that allows you to move all the planned classes to a different term.

#6: Add a Course — Drag & Drop

1. Select courses from the Audit list (“Still Needed” section) on right side of screen
   a. To see which courses are still needed, click blue arrows next to specific section of courses (ex: Foundations of Excellence).
      i. You may follow the course recommendations as indicated on the Program Sequence of your program.
      ii. Example, Human Resource Management, BBA student. Program Sequence for first semester is ACES 100, ENGL 109, MATH 125, CISP 111, and COMM 120.
   b. Click on a course to highlight it, then drag and drop the course to the Fall 2018 term.
   c. Repeat this step to add the other semester courses.
#7: Add a Course Requirement

1. Use the Add Requirement button in specific term
   a. Click on “+” sign in selected term.
   b. From Add Requirement list, select “Course”.
   c. Click into new course field and type in course name (ex: “STAT 220”) and hit Tab key to move to Credits field. Credits will auto-populate.

#8: Move a Course Between Terms — Just Drag & Drop!

1. To move a course between terms in the plan, just drag and drop the course from one term to the desired term.
#9: Delete a Course or Term

**Delete a Course**
1. Highlight the entire line of the course you want to delete.
2. Click on “-” sign (Delete selected requirement) in upper right corner of the term box.

**Delete a Term**
1. In term bar, click on “Delete this term” button.
2. In Delete Term box, click “Yes”.

**Delete a Plan**
1. From View drop-down menu, select “Edit” view.
2. Click on “Delete” button in the lower right corner of screen.
3. In the Delete Plan box, click on “Yes”.

#10: Reassign a Term
1. In a term, click on “Reassign” button.
2. From term drop-down menu, select the new term you wish to use, and click “OK”.
   a. It will only show terms not currently in use in the plan.
#11: Refresh Audit

1. Click “Refresh” in Still Needed section on right side of page. This refreshes the audit based on changes you have made to the plan.
   
a. This step is helpful after you build each term in your plan so you do not duplicate courses in your plan.

![Image of Still Needed section with Refresh button highlighted](image1)

#12: Create a New Plan Using a Selected Template

The university has created SEP Plan templates for each curriculum in our colleges. The templates are designed to match the recommended program sequence documents available on our Programs webpages (https://www.davenport.edu/academic-programs-at-davenport). If you are a new student with few transfer credits, you may benefit from using a SEP Plan template.

1. Select the “Plans” tab.
2. The Create Plan box will appear. Click on “Select Template” if you wish to use an established plan for your curriculum.

![Image of Create Plan box with Select Template highlighted](image2)

3. Scroll down the list of templates (or use the browse field) and click on the name of your curriculum for the appropriate catalog year you began this curriculum.
   
a. You can check your catalog year using the Worksheets tab towards the top of your DegreePlan.
b. “2019” is the 2018-2019 catalog year (“2018” is the 2017-2018 catalog year)
c. Click on the “Open” button (or double-click the template)

4. Select the closest Fall semester you began the program.
   a. The plan will display on your screen.
      i. The description will auto-populate as the name of the template; however, you can change the name of the plan.
      ii. If you wish to make this plan your primary plan, check the “Active” button. You can only have ONE plan marked as Active.
   b. Click on “Save” in the lower right corner of screen.
   c. Click on “Expand All Terms” icon in upper right corner of the plan.

#13: Overview of SEP Template (Symbols & Selections)
Depending on your curriculum, you may find some of the following items in your SEP Template
1. Placeholders: A reminder about a particular requirement
   a. SEP Templates may use a Placeholder Requirement to note an Open Elective, Humanities Elective, Social Science Elective, or Science/Math Elective.
      i. Placeholders do not add course credit to a term
      ii. Placeholders can not drag from one term to another. You would delete it from one term and add it to another term.
b. Add a Placeholder:
   i. In Edit view, in the desired term, click on “+”, select “Placeholder” - the new line will appear at the bottom of the term
   ii. Use the “Select” drop-down menu to select an option
   iii. Information must be entered into Value field such as “Humanities elective - 3 credits”

2. Notes: Provide more detail or instruction about a particular plan, term, or course
   a. To view a Note:
      i. You will know that there is a note entered if the Note icon has lines through it
      ii. Hover over the Note and a viewing box will pop up. You might not see the entire message.
      iii. To view the note in full, click on the lined Note icon
   b. To add a Note:
      i. Click on the Note icon
A Notes box will open up, click on “Add Note” button

Enter any details or instruction that would be helpful to you

Click “Done”

Multiple notes can be added to each item

3. Symbols: How to interpret “@”
   a. MKTG@: Marketing Elective
      i. Any MKTG course may be used to fulfill this requirement
   b. @_@: Open Elective
      i. Any 100+ course may be used to fulfill this requirement
   c. @ @ BUSN
      i. Any 100+ course within the College of Business may be used to fulfill this requirement
   d. 3@:4@ with BUSN
      i. A 300- or 400-level College of Business course will fulfill this requirement
   e. MGMT 3@:
      i. Any MGMT course at the 300-level or higher may be used to fulfill this requirement

Understanding Choice Requirements

#14: Choice Requirement — Selecting a Course from a List of Options
Some programs offer an opportunity for students to choose between two or more options to fulfill a program requirement. In SEP Plans, this is called a Choice Requirement.

1. Scroll through your template to see if there is a choice requirement listed.
   a. In the Edit view, it will be listed like the highlighted FINC line in image below.
   b. Choice requirements can move between terms using the drag and drop method.
2. To view and select the course options - be sure you are in Edit view - double-click on course line and a box will open up that lists the course options for that choice requirement.
3. Select your preferred course by clicking on the radial button.
4. Click on “Done”.
   a. Course will be listed as “Selected” which serves as a reminder that there were other options as well.
5. Click on “Save” in the lower right corner of screen.
6. From View drop-down menu, select “Calendar”.

7. Scroll down the page to see how the selected choice requirement displays in your plan.
   a. Reminder: When opening a saved plan, the system will default to the Calendar view. To begin making changes to a plan, select “Edit” view.
#15: Add Course to Choice Requirement Using Search Button

In a SEP Template, when selecting an elective course from an “@” choice requirement, you will first add the course you would like to take, then select that course.

1. Example: “@ @ with BUSN” choice requirement - this indicates an elective within the College of Business.
2. Click on requirement line and a box will open up that lists the College of Business elective requirement.

3. Click on “Add another option” button. **
   a. ** Note: By using the “Add another option” button, you have the ability to then select one of the options. If you do not use the “add another option” and simply type the selected course into the field, the plan will not show the course as “Selected”.

4. In new course line, click on Search icon (magnifying glass).
5. A Course box will open up.

6. In Course field, type in course discipline. A list of all courses/titles from that discipline will appear.
   a. Click on desired course. This will populate into Choice Requirement box.
   b. Select the added course by clicking on the radial button.
   c. Click on “Done”.
d. Course will be listed as “Selected” which serves as a reminder that there were other options as well.